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本日の内容

インテルの

ハードウェア

インテル® 

ソフトウェア・

ツール/SDK

優れた

並列処理

ソリューション



インテル® SDK for OpenCL* Applications で
メディア・ソリューションや GPGPU アプリケーションを最適化
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インテルのハードウェアはヘテロジニアス

CPU
 優れた汎用パフォーマンス

 大規模なソフトウェア・エコシステム

プログラマブルなインテルのハードウェア
 GPU (ここで説明)

 IPU

 インテル® FPGA (旧 Altera® FPGA) 

動作環境は技術仕様を参照 - インテル® Xeon® プロセッサーまたはインテル Core™ プロセッサー・ベースのプラットフォームの SKU を選択
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主なグラフィックス・テクノロジー
用語集

 実行ユニット (EU) = 汎用コア

 “スライス” には EU、サンプラー、キャッシュなどが含まれる

 固定機能は “アンスライス” に含まれる

 eDRAM はキャッシュを追加し、帯域幅を増加

拡張 別名 要約

インテル® HD 
グラフィックス

GT2
“4+2”

良い

インテル® Iris™ 
グラフィックス

+ スライス
+ eDRAM

GT3
“2+3e”

さらに良い

インテル® Iris™ Pro 
グラフィックス

+ スライス
+ eDRAM

GT3e、GT4e
“4+4e”

最良

各プロセッサー・グラフィックス

intel.co.jp で “インテル® クイック・シンク・ビデオ”を検索してみてください

固定機能
(VDBox、VEBox)
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インテル® プロセッサー・グラフィックス/GPU の概要

GT2
インテル® HD グラフィックス
24 EU、1 MFX

GT3
インテル® Iris™ グラフィックス
48 EU、2 MFX

GT4
インテル® Iris™ Pro グラフィックス
72 EU、2 MFX
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優れた組み合わせ

ヘテロジニアス・ツール
でチップの別の部分にアクセス

インテル® Media Server Studio

 インテル® Media SDK**

 インテル® SDK for OpenCL* 
Applications**

ヘ
テ
ロ
ジ
ニ
ア
ス
・
ハ
ー
ド
ウ
ェ
ア

**スタンドアロン・ツールとしても利用できます。



Linux*

動作環境は技術仕様を参照 - インテル® Xeon® プロセッサーまたはインテル Core™ プロセッサー・ベースのプラットフォームの SKU を選択
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ヘテロジニアス・コンピューティングの実現

CPU
マルチコアによる性能の向上

GPU

グラフィックス API
シェーディング言語

マルチプロセッサー・

プログラミング

例: OpenMP*

Emerging
Intersection

ヘテロジニアス・

コンピューティング

OpenCL* - オープンなコンピューティング言語

汎用的なデータ並列コン

ピューティングの対応強化

オープンで無料 － ポータブルで標準化されている、ヘテロジニアスな並列プログラミング

CPU、GPU やほかのプロセッサー向けの並列コンピューティング
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OpenCL* プラットフォーム・モデル

• 1 つのホスト + 1 つ以上の OpenCL* デバイス
•各 OpenCL* デバイスは 1 つ以上のコンピューティング・ユニットから構成
•各コンピューティング・ユニットはさらに 1 つ以上のプロセシング・エレメントに分けられる

ホスト
プロセシング・
エレメント

コンピューティング・ユニット OpenCL* デバイス
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インテル® SDK for OpenCL* Applications とは

インテル® SDK for OpenCL*
Applications パッケージ

ライブラリー/
ランタイム

ハードウェア
(CPU)

ライブラリー/
ランタイム

ハードウェア
(GPU)

GPU
ドライバー

G
P

U
ド
ラ
イ
バ
ー

パ
ッ
ケ
ー
ジ

開発環境:
SDK とライブラリー・パッケージ
をインストール

ライブラリー/
ランタイム

ハードウェア
(CPU)

ライブラリー/
ランタイム

ハードウェア
(GPU)

GPU
ドライバー

G
P

U
ド
ラ
イ
バ
ー

パ
ッ
ケ
ー
ジ

GPU 実装のターゲット環境:
CPU と GPU の実装有効

ライブラリー/
ランタイム

ハードウェア
(CPU)

ランタイム
パッケージ

CPU のみの
ターゲット環境

• OpenCL* C カーネルコードのコンパイルと解析

• OpenCL* C カーネル/ホストコードのデバッグと性能プロファイル

• Eclipse* IDE に統合された開発環境

• Android™ OS 向けのリモート開発とコンパイル
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インテル® SDK for OpenCL* Applications の機能 (Linux*)

• ビルド、デバッグ、解析:

• Eclipse* IDE への統合

• OpenCL* C カーネル開発フレームワーク

• OpenCL* 2.1 開発環境

• OpenCL* C カーネルデバッグ

• OpenCL* API デバッグとトレース

• Android™ OS 用リモート開発

• OpenCL* API と カーネルの性能解析

• 最新の標準化をサポート:

• OpenCL* 2.1、2.0 & 1.2、PIR、SPIR*-V

• OS とデバイス間でのポータビリティー:

• インテル® プロセッサーとインテル® グラフィックスの
サポート

• Linux* ホストの開発環境

• Linux* ターゲット

• インテル® グラフィックスを搭載したインテル® 
アーキテクチャーに最適:

• 最新のインテル® Core™ プロセッサー、インテル® 
Xeon® プロセッサーの一部

• 共有仮想メモリーによるオンダイのヘテロジニアス・
コンピューティング
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インテル® SDK for OpenCL* Applications 2016 R3の新機能

• 第 7 世代インテル® Core™ プロセッサーのサポート (Microsoft® Windows®/Linux* OS) 

• Windows® 10 Anniversary Update のサポート

• Yocto Project* のサポート

• Linux* OS での OpenCL* 2.1 と SPIR*-V のサポート

• Linux* OS における Kernel Development Framework の新機能サポート

• HW カウンターのサポート

• 第 6 世代、第 7 世代インテル® Core™ プロセッサーのレイテンシー解析
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グラフィックス・ドライバーのサポート状況
https://software.intel.com/en-us/articles/driver-support-matrix-for-media-sdk-and-opencl (英語)

最新の OpenCL* ドライバーの提供
https://software.intel.com/en-us/articles/opencl-drivers (英語)

プロセッサー・
アーキテクチャー

インテル® インテグレーテッド・
グラフィックス

Linux* Windows®

3rd Generation Core,
4th Generation Core
(Ivybridge†/Haswell†)
LEGACY ONLY, downloads 
available but not updated

Ivybridge† - Gen 7 Graphics
Haswell† - Gen 7.5 graphics

16.3 (Intel® Media Server Studio 2015 
R1)
Gold Operating Systems:
Ubuntu* 12.04、SLES 11.3

15.33
Operating Systems:
Client: Windows® 7/8/8.1/10
Server: Windows Server® 2012 r2

4th Generation Core,
5th Generation Core
(Haswell†/Broadwell†)
LEGACY

Haswell† - Gen 7.5 graphics
Broadwell† - Gen 8 graphics

16.4 (Intel® Media Server Studio 
2015/2016)
Gold Operating Systems:
CentOS* 7.1
Generic kernel: 3.14.5

15.36
Operating Systems:
Client: Windows® 7/8/8.1/10
Server: Windows Server® 2012 r2

5th Generation Core
6th Generation Core
(Broadwell†/Skylake†)
CURRENT RELEASE

Broadwell† - Gen 8 graphics
Skylake† - Gen 9 graphics

16.5 (Intel® Media Server Studio 
2017)
Gold Operating Systems:
CentOS* 7.2
Generic kernel: 4.4.0

15.40 (Broadwell†/Skylake† Intel®
Media Server Studio 2017)
15.45 (Skylake† + forward, client)
Operating Systems:
Client: Windows® 7/8/8.1/10
Server: Windows Server® 2012 r2
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サポートしているプラットフォーム (Linux*)

インテル® プラットフォーム
OpenCL*
バージョン

SDK 
プラットフォーム

ターゲット・アプリケーション・プラットフォーム

Ubuntu*
14.04

CentOS*
7.2 

CentOS* 7.2 Ubuntu* 14.04 Yocto* 

CPU GPU CPU 
GPU (w/ 

generic drive) 
CPU GPU 

[NEW] 7th Generation Intel® Core™ Processors 
with Intel® Iris™ Pro Graphics and HD Graphics 

2 ✓ ✓ ✓ ✓ ✓ ✓

[NEW] Intel® Pentium™ Processor N4200/5, 
N3350/5, N3450/5 

2 ✓ ✓ ✓ ✓ ✓

5th and 6th Generation Intel® Core™ Processors 
with Intel® Iris™ Pro Graphics and HD Graphics 

2 ✓ ✓ ✓ ✓ ✓ ✓

Intel® Xeon® Processor E3-1200 v4 Family with 
C226 chipset and E3-1500 v5 Family with C236 
chipset 

2 ✓ ✓ ✓ ✓ ✓ ✓

1st-4th Generation Intel® Core™ Processors (CPU 
only) 

1.2 ✓ ✓ ✓ ✓

Intel® Xeon® Processor Product Family (CPU 
only) 

1.2 ✓ ✓ ✓ ✓

最新の Linux* ドライバー
Intel intel-opencl-r4.1 (SRB4.1) Linux 
driver package (英語) でサポート
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インストール前の準備
• CPU アーキテクチャーの確認

$ grep –m 1 name /proc/cpuinfo

(出力例) model name : Intel(R) Core(TM) i7-6770HQ CPU @ 2.60GHz

• lspci コマンドによるグラフィックス・コントローラーの確認

$ lspci -nn -s 0:02.0 

(出力例) 00:02.0 VGA compatible controller [0300]: Intel Corporation Sky Lake Integrated Graphics 
[8086:193b] (rev 09) 

• インテル® Media Server Studio を使用したハードウェアへのアクセス: 

• インテル® インテグレーテッド・グラフィックスをサポートしているシステムであることを確認

• 通常は、インテル® Core™ プロセッサーか一部のインテル® Xeon® プロセッサーに実装されているが、BIOS
で Enable になっていることを確認

• Eclipse* (Mars か Neon) IDE の確認
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インストール
https://software.intel.com/en-us/articles/getting-started-with-opencl-code-builder (英語)

• インテル® SDK for OpenCL* Applications for Linux* に 2 つのインストーラー

• CentOS* 7.2 用: intel_sdk_for_opencl_2016_6.3.0.<version>_x64.tgz

• Ubuntu* 14.04用: intel_sdk_for_opencl_2016_ubuntu_6.3.0.<version>_x64.tgz

• インストール方法

• TGZ ファイルの解凍

$ tar xzf intel_sdk_for_opencl_2016_6.3.0.<version>_x64.tgz

$ cd intel_sdk_for_opencl_2016_6.3.0.<version>_x64

• インストール・シェルスクリプトの実行 (特権ユーザーで実行)

# ./install.sh または # ./install_GUI.sh

必要なパッケージを選択

インストールに必要なパッケージ

17
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インストール (続き)
• OpenCL* Code Builder の Eclipse* へのプラグイン

• /etc/alternatives/opencl-intel-tools/eclipse-plugin/CodeBuilder_6.3.0.jar ファイルを
Eclipse/dropins ディレクトリーにコピー

• $(INTELOCLSDKROOT)¥bin を LD_LIBRARY_PATH に追加

• Eclipse* で OpenCL* のパスを確認

• 以前のバージョンの jar ファイルを削除

• RPM パッケージの検証

• パブリックキーをインストール・ファイルから解凍

• パブリックキーを rpm データベースにインポート

# sudo rpm --import Intel-E901-172E-EF96-900F-B8E1-4184-D7BE-0E73-F789186F.pub

• RPM パッケージのサインを検証

# rpm –checksig <rpm name>.rpm

(出力例) <rpm name>.rpm: rsa sha1 (md5) pgp md5 OK
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Android™ OS 向けの OpenCL* 開発環境
https://software.intel.com/en-us/code-builder-user-manual (英語)

• Android™ SDK のインストール (https://developer.android.com/studio/install.html (英語))

• Android™ NDK のインストール (https://developer.android.com/ndk/index.html (英語))

• <Android_SDK_Install>¥sdk¥platform-tools を環境変数 PATH に追加

• <Android_SDK_Install>¥sdk¥tools¥android.bat で Android™ SDK Manager を実行

• チェックしてインストール:

• [Android 4.2.2 (API 17)] > [Intel x86 Atom System Image]

• [Extras > [Google USB Driver]

• Android™ デバイスかエミュレーターに OpenCL* ランタイムをインストール
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Android™ エミュレーターの作成
https://software.intel.com/en-us/code-builder-user-manual (英語)

• <Android_SDK_Install>¥sdk¥tools¥android.bat で
Android™ SDK Manager を実行

• Android™ SDK Manager 中で Tools > Manage AVDs..
メニューから新しいエミュレーターを作成

• 作成したエミュレーターを起動

＄ <Android_SDK_Install>¥sdk¥tools¥emulator.exe -avd
test_emulator -partition-size 1024

• エミュレーター動作の確認:

$ adb device

https://software.intel.com/en-us/blogs/2012/03/12/how-to-start-intel-hardware-assisted-
virtualization-hypervisor-on-linux-to-speed-up-intel-android-x86-emulator (英語)
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OpenCL* ランタイムのインストール
https://software.intel.com/en-us/code-builder-user-manual (英語)

• OpenCL* Code Builder をインストールしたディレクトリー下の android-preinstall に移動

• Android™ エミュレーターを手動で起動する:

• Ubuntu* OS の場合 # ./OpenCL_Android_Install -h

• このスクリプトを実行する際には、root のパスワードが必要

• 上記と同様のことを android-preinstall64 に対しても行う

• OpenCL* のランタイムは手動でもインストール可能

• 詳細については、『Developer Guide for Intel® SDK for OpenCL™ Applications』 を参照
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OpenCL* ランタイムのインストール
https://software.intel.com/en-us/code-builder-user-manual (英語)

• Eclipse* IDE の起動: /sdk/adt-bundle-linux-x86_64/eclipse/eclipse

• Eclipse* で Android™ の場所を指定:

• [Window] > [Preferences] > [Android] > [NDK] で
Android™ NDK のパスを入力

• Android™ プロジェクトを作成:

• [File] > [New] > [Project...] > [Android] > 
[Android Application Project]

• プロジェクトに関する情報を追加

• エミュレーターを起動し OpenCL* ランタイムをインストール

• OpenCL* を実装したアプリケーションを開発:

• [Project Explorer] のプロジェクト名で右クリックし、
[Run As] > [1 Android Application] を選択
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インテルの OpenCL* プレビュー機能とは
https://software.intel.com/en-us/articles/opencl-intel-graphics-extensions (英語)

• Khronos* グループの OpenCL* 標準の中で、インテル® プロセッサーに適用可能な
拡張機能

• インテル® SDK for OpenCL* Applications でサポートしている一部の OS、プラットフォームに対応

• フィードバックは “Intel OpenCL forum” (https://software.intel.com/en-us/forums/opencl
(英語)) へ

• 拡張機能の種類

• Media Extensions: ビデオ処理アプリケーションがインテル® プロセッサーのハードウェアにアクセス

• Sharing Extensions: インテル® GPU 上で OpenCL* とほかの API とのインターオペラビリティー

• Subgroups Extensions: サブグループ中のワークアイテム間のデータ共有

• Other Extensions
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Media Extensions
https://software.intel.com/en-us/articles/opencl-intel-graphics-extensions (英語)

• Media Extensions: 一部の OS、プラットフォームに対し HW アクセラレーションを提供

Extension 名 詳細 サポート HW

cl_intel_device_side_avc_motion_estimation
Sample: Intro to Device Side AVC Motion Estimation

Gen9 (new in Linux*
SRB4, not yet available 
for Windows®.)

cl_intel_advanced_motion_estimation
cl_intel_motion_estimation

Motion estimation samples available in Intel® Media Server 
Studio samples

cl_intel_packed_yuv YUV is usually a planar format. This extension provides 
support for a few specific formats of packed YUV images.

cl_intel_planar_yuv
Provides support for the Planar YUV (YCbCr) image 
formats.

Gen9 (new in Linux*
SRB4, not yet available 
for Windows®.)

cl_intel_media_block_io Built-in functions to facilitate the reading and writing of 
flexible 2D regions from images. Augments Intel vendor 
extensions cl_intel_subgroups and 
cl_intel_subgroups_short.

Gen9 (new in Linux*
SRB4, not yet available 
for Windows®.)

VEBox preview extensions:
cl_intelx_video_enhancement
cl_intelx_video_enhancement_color_pipeline
cl_intelx_video_enhancement_camera_pipeline

Samples: Minimal VEBox Samples
More info: OpenCL* Preview Extensions for VEBox

Gen9 (new in Linux*
SRB4, not yet available 
for Windows®.)
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Media Extensions の例
https://software.intel.com/en-us/articles/opencl-intel-graphics-extensions (英語)

Extension 名 詳細 サポート HW

VEBox preview extensions:
cl_intelx_video_enhancement
(VEBox を使用する)
cl_intelx_video_enhancement_color_pipeline
(cl_intelx_video_enhancement と一緒に宣言して
IECP の機能を使用)
cl_intelx_video_enhancement_camera_pipeline
(cl_intelx_video_enhancement と一緒に宣言して
Camera Pipe の機能を使用)

Samples: Minimal VEBox Samples
More info: OpenCL* Preview Extensions for VEBox

Gen9 (new in Linux* SRB4, not 
yet available for Windows®.)
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OpenCL* のサンプルプログラム

• OpenCL* のサンプルプログラム: https://software.intel.com/enus/intel-opencl-support/code-
samples (英語) からダウンロード

• CapsBasic: システムに実装されている OpenCL* の状況を出力
$ cd CapsBasic
$ make
$ ./CapsBasic

• matrix multiply サンプル: カーネルの実行のテスト
$ cd GEMM
$ make;

$ ./GEMM –t gpu

• いくつかの OpenCL* サンプルプログラムは、インテル® Media Server Studio サンプルパッケージに
含まれる

• Motion Estimation: vector motion estimation (VME) extensions の実装例
$ cd samples/ocl_motion_estimation/MotionEstimation
$ make 
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http://www.isus.jp/intel-media-server-studio/
http://www.isus.jp/intel-media-server-studio/
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インテル® SDK for OpenCL* Applications の入手方法

31

インテル® SDK for OpenCL* Applications - 無料

プラットフォーム/デバイス
 インテル® Core™ プロセッサー・ファミリーまたは

インテル® Core™ M プロセッサー・ファミリー

 インテル® クイック・シンク・ビデオをサポートする
インテル® HD グラフィックス内蔵のインテル® Celeron® 

プロセッサー、インテル® Pentium® プロセッサー、
インテル® Atom™ プロセッサーの SKU から選択

 クライアント・デバイス – デスクトップ/

モバイル・アプリケーション

動作環境は技術仕様を参照動作環境は技術仕様を参照

インテル® Media Server Studio – 3 つの
エディション (無料の Community Edition を含む)

プラットフォーム/デバイス
 インテル® Xeon® プロセッサーまたはインテル Core™ プロセッサー・

ベースのプラットフォーム
 メディア、通信インフラストラクチャー、ビデオ処理/テレビ会議、

デジタル監視、ビデオクラウド、データセンター向けアプリケーション
 HEVC、AVC、MPEG-2、MPEG-Audio をサポート

ダウンロード
isus.jp/intel-opencl

ダウンロード
isus.jp/intel-media-server-studio

http://www.isus.jp/intel-media-sdk/
http://www.isus.jp/intel-media-server-studio/
http://www.isus.jp/intel-media-server-studio/
http://www.isus.jp/intel-opencl/
http://www.isus.jp/intel-opencl/
http://www.isus.jp/intel-media-server-studio/
http://www.isus.jp/intel-media-server-studio/
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関連情報

• isus.jp/intel-opencl
インテル® SDK for OpenCL* 

Applications

• isus.jp/intel-media-server-studio
インテル® Media Server 

Studio

• github.com/Intel-Media-SDK/samples (英語)サンプル

• software.intel.com/forums/opencl (英語)フォーラム

Web セミナーのビデオ (英語)

http://www.isus.jp/intel-opencl
http://www.isus.jp/intel-media-server-studio
https://github.com/Intel-Media-SDK/samples
https://software.intel.com/forums/opencl
https://software.intel.com/en-us/videos/get-amazing-intel-gpu-acceleration-for-media-pipelines-webinar-replay
https://software.intel.com/en-us/videos/get-amazing-intel-gpu-acceleration-for-media-pipelines-webinar-replay
https://software.intel.com/en-us/videos/enhance-media-performance-quality-with-intels-media-opencl-sdks
https://software.intel.com/en-us/videos/enhance-media-performance-quality-with-intels-media-opencl-sdks
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法務上の注意書きと最適化に関する注意事項
インテル® テクノロジーの機能と利点はシステム構成によって異なり、対応するハードウェアやソフトウェア、またはサービスの有効化が必要となる場合があります。実際の性能はシステム構成によって異なりま
す。絶対的なセキュリティーを提供できるコンピューター・システムはありません。詳細については、各システムメーカーまたは販売店にお問い合わせいただくか、http://www.intel.co.jp/ を参照してください。

テストでは、特定のシステムでの個々のテストにおけるコンポーネントの性能を文書化しています。ハードウェア、ソフトウェア、システム構成などの違いにより、実際の性能は掲載された性能テストや評価とは異
なる場合があります。購入を検討される場合は、ほかの情報も参考にして、パフォーマンスを総合的に評価することをお勧めします。性能やベンチマーク結果について、さらに詳しい情報をお知りになりたい場合
は http://www.intel.com/performance (英語) を参照してください。

ここに記載されているすべての情報は、予告なく変更されることがあります。インテルの最新の製品仕様およびロードマップをご希望の方は、インテルの担当者、営業所、または代理店までお問い合わせくださ
い。

性能に関するテストに使用されるソフトウェアとワークロードは、性能がインテル® マイクロプロセッサー用に最適化されていることがあります。SYSmark* やMobileMark* などの性能テストは、特定のコン
ピューター・システム、コンポーネント、ソフトウェア、操作、機能に基づいて行ったものです。結果はこれらの要因によって異なります。製品の購入を検討される場合は、他の製品と組み合わせた場合の本製品の
性能など、ほかの情報や性能テストも参考にして、パフォーマンスを総合的に評価することをお勧めします。

本資料に記載されているコスト削減シナリオは、状況固有の多数の変動要因が加わることで、特定のインテル製品の購入が今後のコストとコスト削減にどのように影響するかについて理解を深めることができ
るようにするためのものです。本資料の内容は、一定レベルのコストを保証または確約するものではありません。

本資料に掲載されている情報は、インテル製品の概要説明を目的としたものです。本資料は、明示されているか否かにかかわらず、また禁反言によるとよらずにかかわらず、いかなる知的財産権のライセンス
も許諾するものではありません。製品に付属の売買契約書『Intel's Terms and Conditions of Sale』に規定されている場合を除き、インテルはいかなる責任を負うものではなく、またインテル製品の販売や使用
に関する明示または黙示の保証 (特定目的への適合性、商品適格性、あらゆる特許権、著作権、その他知的財産権の非侵害性への保証を含む) に関してもいかなる責任も負いません。

Intel、インテル、Intel ロゴ、Intel Inside、Intel Inside ロゴ、Intel Atom、Celeron、 Intel Core、 Iris、 Pentium、Xeon、VTune、Altera の名称およびロゴは、アメリカ合衆国および / またはその他の国における Intel 
Corporation の商標です。
Microsoft、DirectX、および Windows は、米国Microsoft Corporation の、米国およびその他の国における登録商標または商標です。
Android はGoogle Inc.の登録商標または商標です。
OpenCL およびOpenCL ロゴは、Apple Inc. の商標であり、Khronosの使用許諾を受けて使用しています。
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最適化に関する注意事項

インテル® コンパイラーでは、インテル® マイクロプロセッサーに限定されない最適化に関して、他社製マイクロプロセッサー用に同等の最適化を行えないことがあります。これには、インテル® ストリー
ミング SIMD 拡張命令 2、インテル® ストリーミング SIMD 拡張命令 3、インテル® ストリーミング SIMD 拡張命令 3 補足命令などの最適化が該当します。インテルは、他社製マイクロプロセッサーに関
して、いかなる最適化の利用、機能、または効果も保証いたしません。本製品のマイクロプロセッサー依存の最適化は、インテル® マイクロプロセッサーでの使用を前提としています。インテル® マイク
ロアーキテクチャーに限定されない最適化のなかにも、インテル® マイクロプロセッサー用のものがあります。この注意事項で言及した命令セットの詳細については、該当する製品のユーザー・リファレ
ンス・ガイドを参照してください。
注意事項の改訂 #20110804
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インテル® Deep Learning SDK Beta
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